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TI-Nspire™ CX II Online Calculator
TI-Nspire™ CX II online calculator is a standalone web-based application that provides
the basic functionality of the TI-Nspire™ CX II graphing calculator on any compatible
computer.

System Requirements

• Browser

- Google Chrome (latest version recommended)

• Computer

- Chromebook™
- Windows® 10 or Windows® 11
- macOS® 12 or 13

• Active internet connection

• Access to shared memory, files, and clipboard

Supported Calculators

• TI-Nspire™ CX II (non-CAS)

Image Disclaimer

Actual products may vary slightly from provided images.

Getting Started
1. Open a compatible browser.

2. Enter nspirecxii.ti.com into the address bar.

If prompted, click Agree and Proceed to accept cookies, and then click ACCEPT
button to agree with the TI terms and conditions.

A compatibility check will be performed while the application loads. If any issues
are found, a page will display with information on what needs to be addressed.

TI-Nspire™ CX II Online Calculator 1
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2 TI-Nspire™ CX II Online Calculator

Note: Click LEARN MORE to view licensing and other information on the TI
Education Technology website.

3. Click the SIGN IN button.

The Texas Instruments SIGN IN dialog will display.

4. Enter your Texas Instruments account sign in credentials.

When the document prompt displays, you can select to open an existing .tns file or
create a new one.

https://education.ti.com/en/products/online-calculators/ti-nspire-cxii
https://education.ti.com/en/products/online-calculators/ti-nspire-cxii


Note: You can only create or open one .tns file at a time.

To open an existing document from your computer

1. Click the OPEN DOCUMENT FROM COMPUTER button.

2. On the Open dialog box, locate and select the document.

3. Click Open.

The document will open in the workspace.

To create a new document

▶ Click the CREATE A NEW DOCUMENT button.

TI-Nspire™ CX II Online Calculator 3
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The calculator workspace is displayed with the app menu open.

Using the Calculator Workspace
The TI-Nspire™ CX II online calculator workspace has three main areas:

Function Bar

Calculator Keypad

Calculator Workspace

Screen Focus

When you are working with the calculator, the area of the screen you were last
interacting with is highlighted with a blue outline. Any keystrokes or keyboard
shortcuts will only affect that part of the screen, if available.

You can change the focus by clicking on one side or the other.

Focus on the calculator keypad:



Focus on the calculator screen:

Function Bar

À Document menu
• New Document

TI-Nspire™ CX II Online Calculator 5



6 TI-Nspire™ CX II Online Calculator

• Open from Computer
• Save to Computer
• Close Document
See Managing Documents for more information.

Á Large Screen: Allows you to toggle between the default large screen view and the full
calculator view.

Â Screen Capture: Allows you to capture the calculator screen for use in other apps.
See Capturing the Calculator Screen for more information.

Ã Connectivity: Launches the TI-Nspire™ CX II Connect app in a new tab where you can
connect your TI-Nspire™ CX II graphing calculator to capture screens, transfer .tns files,
and update the OS.

Ä Help menu
• Help (Online)
• Visit Resources
• About TI-Nspire CX II

Document Tools

À Insert: Allows you to insert a problem, page, or app in the document.

Á Undo/Redo: Allows you to undo or redo the previous action.

Â Previous Page/Next Page: Allows you to navigate between pages in your document.

https://nspireconnect.ti.com/


Resize Bar

You can move the resize bar left or right to dynamically change the size of the keypad
and work area to meet your needs.

Account Info and Sign Out

Clicking the Account Info icon will open a dialog box that displays basic information
about your account.

• Account Info: Your Texas Instruments account email address/user name.

• Subscription Expiration: The date your Texas Instruments subscription will expire.

• SIGN OUT button: Signing out will disconnect you from any Texas Instrument
product your account has access to.

Click anywhere on the screen other than the SIGN OUT button or press the esc button
on your keyboard to return to the calculator workspace.

Managing Documents
Document management with the TI-Nspire™ CX II online calculator is slightly different
than on the graphing calculator. Since your work is based in a browser session, there is
no active file in use.

Therefore, the New, Open, Save, and Close functions are performed with the Function
Bar instead of the Documents > Filemenu options or the X button. Those options have
been disabled in the File menu and the X has been removed from the top right corner
as shown below.

TI-Nspire™ CX II Online Calculator 7
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CAUTION: Any changes you make to a document are not auto-saved. They only exist in
the current browser session. You must manually save them (see the Save to Computer
section below) in order to capture any changes since the last save.

Also note that:

• Each document is divided into at least one, and up to 30, problems.

• Each problem contains at least one, and up to 50, pages.

• Each page can be divided into as many as four work areas.

• Each work area can contain any of the TI-Nspire™ applications (Calculator, Graph,
Geometry, Lists & Spreadsheet, Data & Statistics, Notes, Program Editor, and
Python).

New Document

Note: These steps are for the workspace page. You can also create a new document on
the Document Prompt page.

To create a document

1. Click the Document icon on the Function Bar.

2. Click New Document.

The workspace will refresh and display an empty document.

Open from Computer

Note: These steps are for the workspace page. You can also open an existing document
on the Document Prompt page.

To open a document

1. Click the Document icon on the Function Bar.

2. Click Open from Computer.

3. Select the file you want to open and click Open.

The workspace will refresh and display the document you chose.

Save to Computer

To save a document

1. Click the Document icon on the function bar.

2. Click Save to Computer.

3. Select the location where you want to save the document.

4. Enter a name for the document and click Save.

If you use an existing document name, you will be prompted to overwrite the
document.



If there are unsaved changes to your document, you will be prompted to save that
document if you try to:

• create a new document,

• open an existing document,

• or close the current document.

If you try to close or reload the browser tab or window, a browser dialog box will
display indicating that there are unsaved changes. You can then choose whether to
continue without saving, or cancel and save the latest changes.

Close Document

To close a document

1. Click the Document icon on the function bar.

2. Click Close Document.

You will be returned to the Document Prompt page to open a document from your
computer or create a new document.

Capturing the Calculator Screen
After creating content in one of the calculator apps, you can capture the calculator
screen to save or share with others.

To capture the calculator screen

1. Click the Screen Capture icon on the Function Toolbar.

2. Click the CAPTURE SCREEN button.

The current calculator screen will display.

TI-Nspire™ CX II Online Calculator 9
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Note: You can only capture one screen at a time. To capture another screen, make
the necessary changes on the calculator and click the CAPTURE SCREEN button
again.

3. Click one of the following buttons:

- Copies the current screen to the computer clipboard and use the image in

other apps.

- Saves the current screen to your computer.

You can also drag-and-drop the image to other apps like Google docs, Microsoft
Word, etc.

Tip: To see the entire calculator workspace while capturing the screen, use the Resize
Bar to shrink the size of the keypad until the workspace is no longer blocked by the
screen capture popup.

TI-Nspire™ CX II Online Calculator Keys
Use the calculator keypad as you would the TI-Nspire™ Touchpad.

d Removes menus or dialog boxes from
the screen. Also stops a calculation in
progress.

c Displays the home screen.

~ Opens the Document menu.



» Opens the Scratchpad for performing
quick calculations and graphing.

eMoves to the next entry field.

gMakes the next character typed
upper-case.

/ Provides access to the function or
character shown above each key. Also
enables shortcuts in combination with other
keys.

bDisplays the application or context
menu.

. Deletes the previous character.

h Displays stored variables.

· Evaluates an expression, executes an
instruction, or selects a menu item.

Note: A ¢ symbol on a key indicates access to multiple options. To access an option,
pressº repeatedly or use the arrow keys on the calculator keypad. Press· or click
to select the option.

The TI-Nspire™ CX II Online Calculator Screen
When you are working in a document, icons at the top of the screen provide
information about the status of operations and provide an easy way to change settings.
The icons are described below.

Icon Function

¡ ¢ Page scrolling arrows - Use the calculator keypad to click these arrows and
scroll through the pages in a document.

Page tab - Labels the problem number and page number of the active page.
For example, a label of 1.2 identifies Problem 1, Page 2. If problems are

TI-Nspire™ CX II Online Calculator 11
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Icon Function

named, hover the pointer over a tab to view the page name.

*Doc Document name - Shows the current document name. An asterisk by the
document name indicates changes were made since the document was last
saved. Click the name to open the Documentsmenu.

CAPS Shows status of theg,/, and Ê keys.

RAD Angle Mode - Shows an abbreviation of the angle mode (Degrees, Radians,
or Gradians) in effect. Hover the pointer over the indicator to see the full
name.
Note: Click the indicator to toggle between RAD and DEG modes.

Settings & Status - Click the icon to open the Settings & Statusmenu.

Using Hints
Hints are quick tips available throughout the software. There are several easy ways to
access Hints:

• Press /µ.

• Some dialog boxes contain a question mark icon. Click this icon to open Hints for
that task.

To scroll through the Hints, use the Touchpad or arrow keys:

• To page down, press/3.

• To page up, press/9.

• To go to the end of the Hints file, press/1.

• To go back to the beginning of the file, press/7.



Using the Scratchpad
The Scratchpad is a feature of the TI-Nspire™ CX II online calculator that lets you
quickly:

• Evaluate math expressions.

• Graph functions.

Inserting Items from the Catalog
You can use the Catalog to insert functions and commands, symbols, and expression
templates into the entry line.

1. Pressk to open the Catalog. By default, the first tab is displayed, which lists all
commands and functions in alphabetical order.

2. If the function you are inserting is visible in the list, select it and press· to
insert it.

3. If the function is not visible:

a) Press a letter key to jump to the entries that begin with that letter.

b) Press¤ or£ as necessary to highlight the item you are inserting.

c) Click a numbered tab to list functions by category: math functions, symbols,
math templates, library objects, and value for standard measurement units.

d) Press· to insert the item into the entry line.

Using an Expression Template

Templates help you enter matrices, piecewise functions, systems of equations,
integrals, derivatives, products, and other math expressions.

For example, suppose you want to evaluate

1. Presst to open the Template palette.

Using the Scratchpad 13



14 Using the Scratchpad

2. Select to insert the algebraic sum template.

The template appears on the entry line with small blocks representing elements
that you can enter. A cursor appears next to one of the elements to show that you
can type a value for that element.

3. Use the arrow keys to move the cursor to each element’s position, and type a value
or expression for each element.

4. Press· to evaluate the expression.

Inserting Expressions Using a Wizard

You can use a wizard to simplify entering some expressions. The wizard contains
labeled boxes to help you enter the arguments in the expression.

For example, suppose you want to fit a y=mx+b linear regression model to the
following two lists:

{1,2,3,4,5}
{5,8,11,14,17}

1. Pressk1 to open the Catalog and show the alphabetic list of functions.

2. Click inside the list, and then pressL to jump to the entries that begin with “L.”

3. Press¤ as necessary to highlight LinRegMx.

4. If theWizards On option is not checked, pressee to highlightWizards On.

5. Press· to change the setting.

6. Pressee to highlight LinRegMx again.



7. Press·.

A wizard opens, giving you a labeled box to type each argument.

8. Type {1,2,3,4,5} as X List.

9. Presse to move to the Y List field.

10. Type {5,8,11,14,17} as Y List.

11. If you want to store the regression equation in a specific variable, presse, and
then replace Save RegEqn To with the name of the function variable (f1 through
f99).

12. Click OK to close the wizard and insert the expression into the entry line.

The expression is inserted along with statements to copy the regression equation
and display the variable stat.results, which will contain the results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: stat.results

The Scratchpad then displays the stat.results variables.

Using the Scratchpad 15



16 Using the Scratchpad

Note: You can copy values from the stat.results variables and paste them into the
entry line.

Viewing the History
Each evaluated expression and result becomes part of the Scratchpad history, displayed
above the entry line.

▶ Press£ or¤ to scroll through the history.

Copying a History Item to the Entry Line

You can quickly copy an expression, subexpression, or result from the history into the
entry line.

1. Press£ or¤ to move through the history and select the item that you want to
copy.

2. Optionally, select part of the expression or result by usingg in combination
with the arrow keys.

3. Press· to copy the selection and insert it into the entry line.



Clearing the History

When you clear the history, all variables and functions defined in the history retain
their current values. If you clear the history by mistake, use the undo feature.

▶ From the Actionsmenu, click Clear History.

—or—

Pressb15.

All expressions and results are removed from the history.

Editing Scratchpad Expressions
Although you cannot edit a Scratchpad Calculate expression in the history, you can
copy all or part of an expression from the history and paste it to the entry line. You can
then edit the entry line.

Inserting Elements into the Entry Line

1. Presse, ¡, ¢,£, or¤ to position the cursor in the expression.

The cursor moves to the closest valid position in the direction that you press.

2. Type the elements or insert them from the Catalog.

Selecting Part of an Expression

You can delete, cut, or copy a selected part of an expression.

1. Press ¡, ¢,£, or¤ to move the cursor to a starting point in the expression.

2. Press and holdg and press ¡, ¢,£, or¤ to select.

- To delete the selection, press..

- To cut the selection to the Clipboard, press/X.

- To copy the selection to the Clipboard, press/C.

- To paste the selection to a new entry line in Scratchpad, press/V.

Graphing with the Scratchpad

1. Press» to open the Scratchpad Graph page if it is not already open.

By default, the entry line is displayed. The entry line displays the required format
for typing a relation. The default graph type is Function, so the form f1(x)= is
displayed.

Using the Scratchpad 17



18 Using the Scratchpad

If the entry line is not shown, press Ctrl + G or pressb23 to display the
entry line and type an expression to graph.

2. Pressb > Graph Entry/Edit and select a graph type.

For example:

• To graph an equation for a circle, pressb > Graph Entry/Edit > Equation >
Circle > (x-h)2 + (y-k)2 = r2 or pressb3231. Fill in the equation and
press· to draw the circle.

• To graph a function, pressb > Graph Entry/Edit > Function or press
b31.

The entry line changes to display the expression format for the specified graph
type. You can specify multiple relations of each graph type.

3. Type an expression and any other parameters required for the graph type.

4. Press· to graph the relation, or press¤ to add another relation. If necessary,
you can use pressb4 to choose a tool on the Window/Zoommenu and adjust
the viewing area.

When you graph the relation, the entry line disappears to show an uncluttered
view of the graph. If you select or trace a plot, the relation that defines the plot is
displayed on the entry line. You can modify a plot by defining a relation or by
selecting and changing the graph.

As you graph multiple plots, the defining relation is displayed for each. You can
define and graph a maximum of 99 relations of each type.

5. Use theb key to explore and analyze the relation to:

• Trace the relation.
• Find points of interest.
• Assign a variable in the expression to a slider.

Viewing the Table

▶ To display a table of values corresponding to the current plots, pressb > Table >
Split-screen Table (b71).



▶ To hide the table, click the graph side of the split screen, and then pressb >
Table > Remove Table (b72). You can also press Ctrl + T.

▶ To resize columns, click the table and pressb > Actions > Resize (b11).

▶ To delete a column, edit an expression, or edit table settings, click the table and
pressb > Table (b2).

Changing the Appearance of the Axes

As you work with graphs, the Cartesian axes are displayed by default. You can change
the appearance of the axes in the following ways:

1. Pressb4 and choose the Zoom tool to use.

2. Select the axes and press/b2 to activate the Attributes tool.

a) Press£ or ¤ to move to the attribute to change. For example, choose the end
style attribute.

b) Press ¡ or ¢ to choose the style to apply.

c) Change any other attributes of the axes as required for your work, and then
press· to exit the attributes tool.

3. Adjust the axes scale and tic mark spacing manually.

a) Click and hold one tick mark, and move it on the axis. The spacing and number
of tic marks increases (or decreases) on both axes.

b) To adjust the scale and tic mark spacing on a single axis, press and holdg,
and then grab and drag a tic mark on that axis.

4. Change axis end values by double-clicking them and typing new values.

5. Adjust the location of the axes. To move the existing axes without resizing or
rescaling them, click in and drag an empty region of the screen until the axes are in
the desired location.

6. Change the axes’ scales by pressingb > Window/Zoom > Window Settings
(b41).

Using the Scratchpad 19



20 Using the Scratchpad

Type the values of your choice over the current values for x-min, x-max, y-min, y-
max, Xscale, and Yscale and click OK.

7. Pressb > View > Hide Axes (b21) to hide or show the axes.

• If the axes are shown on the page, selecting this tool hides them.
• If the axes are hidden on the page, selecting this tool redisplays them.

Tracing a Plot

Graph Trace moves through the points of a graphed function, parametric, polar,
sequence, or scatter plot. To enable the trace tool:

1. Pressb > Trace > Graph Trace (b51) to move across the plot in Trace
mode.

2. (Optional) To change the trace step increment for tracing, pressb53.

After you type a different step increment, the Graph Trace tool moves across the
graph in steps of that size.

3. Use Graph Trace to explore a plot in the following ways:

• Move to a point and hover to move the trace cursor to that point.

• Press ¡ or ¢ to move from point to point on the function’s graph. The
coordinates of each point traced are displayed.

• Press£ or ¤ to move from one plot to another. The point’s coordinates
update to reflect the new location of the trace. The trace cursor is positioned
on the point of the new graph or plot with the closest x value to the last point
identified on the previously traced function or graph.

• Type a number and press· to move the trace cursor to the point on the
plot with independent coordinates nearest the typed value.

• Create a persistent point that remains on the graph by pressing· when the
trace point reaches the point you want to label. The point remains after you
exit Graph Trace mode.

Notes:



• The string undef is displayed instead of a value when you move over a point
that is not defined for the function (a discontinuity).

• When you trace beyond the initially visible graph, the screen pans to show the
area being traced.

4. Pressd or choose another tool to exit Graph Trace.

Finding Points of Interest

You can use the tools on the Analyze Graphmenu to find a point of interest in a
specified range of any graphed function. Choose a tool to find zero, the minimum or
maximum, the point of intersection or inflection, or the numeric derivative (dy/dx) or
Integral on the graph.

1. Select the point of interest that you want to find on the Analyze Graphmenu. For
example, to find a zero, pressb61.

Zero b61

Minimum b62

Maximum b63

Intersection b64

Inflection Not applicable

dy/dx b65

Integral b66

Analyze Conics b67

The icon for the selected tool is displayed at the top left on the work area. Point to
the icon to view a tooltip about how to use the selected tool.

2. Click the graph you want to search for the point of interest, and then click a second
time to indicate where to start the search for the point.

The second click marks the lower bound of the search region and a dotted line is
displayed.

Note: If you are finding the derivative (dy/dx), click the graph at the point (numeric
value) to use for finding the derivative.

3. Press ¡ or ¢ to move the dotted line that marks the search region, and then click
the point at which you want to stop the search (upper bound of the search region).
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22 Using the Scratchpad

4. Press· at the point to start the search. The tool shades the range.

If the search region you specified includes the point of interest, a label for the point
is displayed. If you change a graph that has points of interest identified, be sure to
check for changes in points of interest. For example, if you edit the function on the
entry line or manipulate a plot, the point where the graph intersects zero can
change.

The labeled points of interest remain visible on the graph. You can exit the tool by
pressingd or choosing another tool.



Working with Documents on the TI-Nspire™ CX II Online
Calculator
All of the work you do with the TI-Nspire™ CX II online calculator is contained in one or
more TI-Nspire™ documents, which you can share with other users and with those
using the computer software.

• Each document is divided into at least one, and up to 30, problems.

• Each problem contains at least one, and up to 50, pages.

• Each page can be divided into as many as four work areas.

• Each work area can contain any of the TI-Nspire™ applications (Calculator, Graph,
Geometry, Lists & Spreadsheet, Data & Statistics, and Notes).

Working with Applications
Options for working with applications include:

• Creating a new document and selecting an application

• Adding a new page and application to an open document

• Adding multiple applications to a page in a document

Adding an Application

There are multiple ways to add an application to a page:

• When creating a new document, use the Touchpad or corresponding numbers to
select an application from the list of applications.

• To add a new page and application to an open document, press/~ and then
select an application from the list.

For example, press2 to add the Graph application to the page. The application
opens in the work area.

Working with Documents on the TI-Nspire™ CX II Online Calculator 23
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You can also press c, and then select an application from the Home screen by
clicking one of the following application icons:

Calculator

Graphs

Geometry

Lists & Spreadsheet

Data & Statistics

Notes

Using Multiple Applications on a Page

You can add up to four applications to each page.

When you create a new document, it contains space to add one application. If you
need to add more than one application to a page, you can change the layout to
accommodate as many as four applications.

You can choose a standard layout, provided as a menu item, or you can customize a
layout to suit your needs.

Choosing a Standard Page Layout

1. Press~52 to display layout options.

2. Press the number that corresponds to the layout you want.

For example, press2 to create a two-pane layout, divided vertically on the page.



3. Press/e to move between panes. Bold lines around the pane indicate that
the pane is active.

4. Pressb, and then press the number of the application you want to add the new
pane. For example, press4 to add the Lists & Spreadsheet application.

Note: If you need to change the layout of the page to add or delete applications,
you can do so at any time. When deleting an application, select the application to
be deleted first.

Creating a Custom Page Layout

If the standard layouts do not meet your needs, you can customize the space allotted
to applications on a page.

1. Press~5 to display layout options.

Working with Documents on the TI-Nspire™ CX II Online Calculator 25
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2. Press1 to select the custom split option.

The standard layout is displayed with a divider between the application panes. Use

the arrows ( ) in the middle of the divider to adjust the size of the panes.

3. Press£, ¤, ¡, or ¢ to move the divider to adjust the height or width of the panes
in the layout.

4. Press+ or- to select a defined layout:

• Pressing- returns to a full page layout.

• Pressing+ once switches layout from a vertical layout to a horizontal layout.
Press- to go back to a vertical layout.

• Pressing+ twice adds a third pane to the page. Pressing+multiple times
enables you to choose between a vertical and horizontal page layout with three
panes.

• Pressing+ five times adds a fourth pane to the page. Press- to cycle
through the previous layout options.

5. Pressx or · to accept the layout dimensions.



6. Press/e to move between panes. Bold lines around the pane indicate that
the pane is active.

Swapping Applications on a Page

If you want to change the position of applications on a page with multiple applications,
you can do so by “swapping“ the positions of two applications.

1. Press~5 Page Layout4 Swap Application.

The selected application is surrounded by a heavy, flashing black border, and the
Swap App cursor é is displayed on the screen.

Note: On a two-pane page layout, the selected application automatically swaps
position with the opposite pane. Press x or · to complete the swap.

2. Press£, ¤, ¡, or ¢ to position the cursor over the application you are targeting to
swap.

3. Pressx or · to complete the swap.

Note: Pressd to cancel the swap.

Grouping Applications

To group up to four application pages into a single page:

1. Select the first page in the series.

2. From the Documentmenu, select Page Layout > Group.

Press~57.

The next page is grouped with the first page. The page layout automatically adjusts
to display all the pages in the group.

Ungrouping Pages

To ungroup the pages:

1. Select the grouped page.

2. From the Documentmenu, select Page Layout > Ungroup.

—or—

Press~58.

The material becomes individual pages for each application.

Deleting an Application from a Page

1. Click the application you want to delete.

2. From the Documentmenu, select Page Layout > Delete Application.

—or—
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Press~55.

The selected application is deleted.

If you want to undo the delete, press Ctrl-Z.

Context Menus
Context menus display options that are specific to the selected object or the current
cursor location.

Using the Context Menu

▶ To access a context-sensitive menu from an application, press/b.

In the example below, the context menu displays options available for the selected
cell in Lists & Spreadsheet.

Working with Problems and Pages
The options on the Documentsmenu let you:

• Save a document

• Access edit functions such as undo, redo, cut, copy, paste, and delete

• Move between pages and open the page sorter view for documents with multiple
pages

• Modify page layout, insert pages or problems, delete pages, and change settings

• Add problems, pages, and applications to open documents

• Access page layout options

Adding a Problem to a Document
Adding problems to a document enables you to reuse variable names. A document can
contain as many as 30 problems. To add a new problem:

1. Press~41 to open the Insert options.



A new problem with one page is added to the document. The tab at the top left of
the screen indicates that this is the first page of the second problem.

2. Press b to open the Application menu, and then, press the number
corresponding to the application you want to add to the new page.

Viewing and Reordering Pages in a Document
The Page Sorter displays all of the problems in your document and all pages within
each problem in thumbnail format. You can use the Page Sorter to rearrange and
delete pages, copy a page from one problem and paste it into another, and apply
templates to pages.

Viewing Multiple Pages with the Page Sorter

Although the online calculator typically displays the pages in your document one at a
time, the Page Sorter lets you see all of the problems in your document and all pages
within each problem in thumbnail format. You can use the Page Sorter to rearrange
and delete pages, and copy a page from one problem and paste it in another.

Opening the Page Sorter from a Document

▶ Press/£.
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The Page Sorter screen displays all of the problems and pages in the current
document.

Reordering Pages in a Problem

Use the Page Sorter (press/£) to move a page within a problem with multiple
pages:

1. Press the ¡ or ¢ key to select the page you want to move.

A heavy border around the page indicates that it is selected.

2. Either press and holdx or press/x until the grab cursor÷ is displayed.

3. Press ¡, ¢,£, or¤ to move the page to the desired position.

4. Pressx or· to finish the move.

Note: You can pressd to cancel.

The page moves to the new location within the problem, and the counter adjusts
accordingly.



Copying a Page to Another Problem

To copy a page from one problem to another in the same document:

1. Press/£ to open Page Sorter.

2. Press ¡, ¢,£, or¤ to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press/C to copy the page.

4. Press ¡, ¢, £, or¤ to select the desired position in the problem where you will
paste the page. The copied page will be placed after the page you select.

5. Press/V to paste the page in the new location.

The page is copied to the new location within the problem, and the counter adjusts
accordingly.

Note: If the page contains variables with the same names as the new problem, a
conflict may occur. Rename the variables if necessary.

Copying a Page to Another Document

To copy a page from one document to another document:

1. Press/£ to open the Page Sorter.

2. Press ¡, ¢, £, or¤ to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press/C to copy the page.

4. Pressc2 to open My Documents.

5. Press£ and¤ to highlight the folder containing the document you want to copy
the page to.

6. Press ¢ to open the folder.
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—or—

Pressb3.

7. Press the£ and¤ keys to highlight the document.

8. Pressx or· to open the document.

9. Press/£ to display the Page Sorter.

10. Press ¡, ¢,£, or¤ to move the page to the desired position in the document.

11. Press/V to paste the page in the new location.

The page moves to the new location within the problem, and the counter adjusts
accordingly.

Understanding the TI-Nspire™ Tools
This section provides an overview of the tools used when working with TI-Nspire™
documents including variables, catalog, symbols, and math templates.

Creating TI-Nspire™ Variables

Variables can be any portion or attribute of an object or function created within an
application. Examples of attributes that can become variables are the area of a
rectangle, the radius of a circle, the value contained in a spreadsheet cell or the
contents of a column, or a function expression. When you create a variable, it is stored
in memory within the problem. You will find more information about variables in the
chapter titled Using Variables.

Using the Catalog

Use the catalog to access a list of TI-Nspire™ commands and functions, units, symbols
and expression templates. Commands and functions are listed alphabetically.
Commands or functions not beginning with a letter are found at the end of the list (&,
/, +, -, and so on). To open the catalog:

1. From an open document, pressk to open the catalog.



2. Press the number key corresponding to the appropriate tab.

For example, press2 to show a list of math functions.

3. Press 6 until the item you want to insert is highlighted.

A syntax example for the selected item is displayed at the bottom of the screen.

Note: To see additional syntax examples of the selected item, presse, and then
press· to maximize or minimize the Help. To move back to the selected item,
pressge.

4. Press· to insert the item.

About the Catalog Window

The catalog window uses these tabs to categorize commands, special characters, and
templates in documents:

Contains all commands and functions, in alphabetical order

Contains all math functions

Provides the values for standard measurement units

Provides a symbol palette for adding special characters

Contains math templates for creating two dimensional objects, including
product, sum, square root, and integral

Shows public library (LibPub) objects.

Using Wizards

Some catalog functions have a wizard to help you enter function arguments. To use a
wizard, presse until theWizards On box is highlighted. Pressx or · to select
the check box.
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Entering Special Characters

The symbol palette contains a subset of the objects found in the catalog. To open the
symbol palette:

1. In an open document, press/k.

2. Press ¡, ¢,£, or¤ to select a symbol.

3. Press· to insert the symbol.

Entering Math Expressions

Use math expression templates to create two-dimensional objects such as summation,
integral, derivative, and square root. To open the math expressions palette:

1. In an open document, presst.



2. Press ¡, ¢,£, or¤ to select an expression.

3. Pressx or · to insert the expression.

Entering International Language Characters

Use the; key to enter specially accented or punctuated characters in applications
such as Notes that allow text input.

1. Open an application such as Notes that allows text input.

2. Type the desired text.

3. Position the cursor after the letter that you want to accent. For example, “e” while
in the French locale.

4. Press; on the keypad. Notice that the “e" changes to “é.“ Keep pressing; until
you find the accented version of e that you want. Press_ or the next letter of
your text to accept the character and continue typing.

Keyboard Shortcuts
Use the keypad mapping to computer keyboard for Windows®, Mac®, and
Chromebook™.

You can use your computer keyboard to press a key instead of pressing that key on the
TI-Nspire™ CX II online calculator keyboard image.

Note:Mac® users should substitute “ (Cmd) anywhere ctrl is used.

Keys Function Keypad Computer
Keyboard

alt + enter Add a row to a matrix Not
supported

Yes

ctrl + 0 Scratchpad or toggle between
Scratchpad apps

Not
supported

Yes
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Keys Function Keypad Computer
Keyboard

ctrl + 1 Move to end of list/page down Yes Yes

ctrl + 2 End of line Yes Yes

ctrl + 3 Page down Yes Yes

ctrl + 4 Merge two pages into split screen. Yes Yes

ctrl + 6 Convert split screen into two pages Yes Yes

ctrl + 7 Move to top of list/page up Yes Yes

ctrl + 8 Beginning of line Yes Yes

ctrl + 9 Page up Yes Yes

ctrl + A Select all Yes Yes

ctrl + B Check Syntax and Store Yes Yes

ctrl + C Copy Yes Yes

ctrl + E Insert a Chem Box Yes Yes

ctrl + F Find Yes Yes

ctrl + G Toggle Graph Entry Line Yes Yes

ctrl + G Go to cell/Go to line Yes Yes

ctrl + H Find and Replace Yes Yes

ctrl + I Insert page Yes Yes

ctrl + J Take screen capture Yes Yes

ctrl + K Select page (in split screen) Yes Yes

ctrl + L Display variable list Yes Yes

ctrl + L Store or link to variable Yes Yes

ctrl + M Insert Math Box Yes Yes

ctrl + N New document Yes Yes



Keys Function Keypad Computer
Keyboard

ctrl + O Open document Yes Yes

ctrl + P Print document Yes Yes

ctrl + R Recalculate Yes Yes

ctrl + S Save document Yes Yes

ctrl + T Toggle Table/Comment Yes Not
supported

ctrl + V Paste Yes Yes

ctrl + W Close current document Yes Yes

ctrl + X Cut Yes Yes

ctrl + Y Redo Yes Yes

ctrl + Z Undo Yes Yes

ctrl + ' Degree (°) symbol Not
supported

Yes

ctrl + - Ans Yes Not
supported

ctrl + - Make screen dimmer Yes Yes

ctrl +( Square brackets [] Yes Not
supported

ctrl +) Curly brackets {} Yes Not
supported

ctrl + * Template Palette/Double quotes Yes Not
supported

ctrl + * String Yes Not
supported

ctrl + . Manual data capture Yes Yes

ctrl + / Fraction template Yes Yes

ctrl +Î Hints Yes Not
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Keys Function Keypad Computer
Keyboard

supported

ctrl +k Show symbol template Yes Not
supported

ctrl +l Nth root Yes Not
supported

ctrl + + Make screen brighter Yes Yes

ctrl + = Inequality pop over/menu Yes Yes

ctrl +s Log() Yes Not
supported

ctrl +Ï Assignment operator Yes Not
supported

ctrl + click Grab an object Yes Not
supported

ctrl +. Clear entry Yes Not
supported

ctrl +~ Insert page in new open document Yes Not
supported

ctrl +u ln() Yes Not
supported

ctrl +· Approximate / Force decimal result Yes Yes

ctrl +d Undo Yes Not
supported

ctrl +b Context menu Yes Not
supported

ctrl +c Off Yes Not
supported

ctrl +» Save/Save As Yes Not
supported

ctrl +g Caps lock Yes Not
supported



Keys Function Keypad Computer
Keyboard

ctrl +_ Underscore Yes Not
supported

ctrl +
Ë/h

Store a variable / Arrow symbol /
Equals

Yes Not
supported

ctrl +e Toggle between split screen windows Yes Not
supported

ctrl + tab Toggle between open documents Not
supported

Yes

ctrl +µ Hints Yes Not
supported

ctrl + up
arrow

Navigate the document hierarchy Yes Yes

ctrl +h Store a variable Yes Not
supported

ctrl +q Square root Yes Not
supported

c Toggle between Home and Current
open document

Yes Not
supported

shift +@ Add a column to a matrix Yes Not
supported

shift +- Derivative Yes Not
supported

shift + / \ Symbol Yes Not
supported

shift + + Integral Yes Not
supported

shift +
arrows

Highlight selected text Yes Yes

shift +· Add a column to a matrix Yes Not
supported

shift +d Redo Yes Not
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Keys Function Keypad Computer
Keyboard

supported

shift + tab Move back through fields or zones Yes Yes

shift + tab Dedent Yes Yes

tab Indent Yes Yes

tab Move through fields or zones Yes Yes

tab Display graph entry line Yes Yes

@ Add a row to a matrix Yes Not
supported



General Information
Online Help
education.ti.com/eguide

Select your country for more product information.

Contact TI Support
education.ti.com/ti-cares

Select your country for technical and other support resources.

Service and Warranty Information
education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243
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